Description

Damage Analysis of
a Composite Plate

For LUSAS version: 23.0
For software product(s): | LUSAS Composite Plus
With product option(s): | Nonlinear.

Note: The example exceeds the limits of the LUSAS Teaching and Training Version.

Description

A Imm thick
composite plate made
up from an IM Carbon
cross ply laminate is
placed under tensile
loading to analyse the
damage growth and
stress  redistribution
around a stress
concentration caused
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30 mm

10 mm Diameter

O

by a 10mm diameter hole. Because of symmetry a quarter model will be created.

Units used are N, mm, t, s, C throughout.

Objectives

The objective of the analysis is:

O To determine the onset of damage growth
O To predict the effect of damage growth on the stress distribution within the

composite stack
Keywords

3D, Composite, Hashin, Damage, Nonlinear
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Modelling

Damage Analysis of a Composite Plate

Associated Files

Associated files can be downloaded from the user area of the LUSAS website.

0 composite_plate_modelling.lvb This file carries out the modelling of
the example.

Running LUSAS Modeller

For details of how to run LUSAS Modeller, see the heading Running LUSAS
Modeller in the Introduction to LUSAS Worked Examples document.

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command
File>New to start a new model file. Modeller will prompt for any unsaved data and
display the New Model dialog.

Creating a new model
o Enter the filename as composite_plate
e Ensure an Analysis type of Structural is set.
e Set the Analysis category to be 3D
e Set the model units as N,mm,t,s,C
o Ensure that timescale units are Seconds
e Select the Startup template Composite
e Ensure the Layout grid is set as None
o Enter the title as Damage Analysis of Composite Plate
e Click the OK button.
Note. Save the model regularly as the example progresses. Use the Undo button to

correct any mistakes made since the last save was done.

Feature Geometry

The composite plate will be modelled as a quarter model and symmetry boundary
conditions will be used to reduce the size of the model. Firstly the hole will be defined.
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Modelling

\%

Line

Arc/Circle >

From

| Geometry
Line
By Coords...

\%

| Geometry
Line
By Points...

\%

| Geometry
Line >
By Points...

| Geometry
Surface >
By Lines...

Coords/Points...

¢ Enter coordinates of (5, 0), (0, 5) and (0, 0)

e Select the Centre option next to the (0, 0) coordinate entry and click the OK
button.

Now define the lines representing the edges of the specimen.

il Enter coordinates of (35, 0), &
(35, 15) and (0,15) and click the
OK button.

Points on vertical
plane of symmetry

Now create the lines on the

symmetry planes. Points on horizontal

@ plane of symmetry %

il Create a line along the horizontal line of symmetry.

e Select the two points on
the horizontal plane of
symmetry

o Select the two points on the vertical plane of symmetry.

il Create a line along the vertical
line of symmetry.

)

- ¥

Now create a surface from the boundary lines.

e Change the selection mode so only Lines are selected from the display. Click
and hold the left-hand mouse button on the selection button il, then click on
the il button to select only lines.

e Box-select all the lines in the model by clicking and dragging the cursor around
all the lines that form the surface.

J Create a general surface from the selected lines.

e Change the selection mode back to the default pointer il and click in a blank
area of the view window to deselect any selected features.
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| Attributes
Mesh >
Line...

| File

Model Properties. ..

| Geometry
[ Volume >

By Sweeping...

Damage Analysis of a Composite Plate

Meshing

In this example the mesh will be graded manually by specifying the number of
elements on each of the boundary lines. The mesh pattern will not be visible until a
volume mesh assignment has been made.

Define a null line mesh with 16 divisions.
e Enter 16 in the number of divisions.
o Enter the dataset name as Null, divs = 16 and click the OK button.

e Use the Ctrl and A keys together to select all the features and assign Null, divs
=16 from the o Treeview to all lines.

e Select the upper horizontal line representing the edge of the plate and assign the

line mesh dataset Null, divs = 8 from the & Treeview. This will overwrite the
previous assignment.

e Select the line on the right hand side of the model and assign Null, divs = 2
from the P 3 Treeview. This will overwrite the previous assignment.

Creating a volume

The surface will now be swept through the depth of the plate to create a volume. Lines
on the newly created surface on the back face of the volume will automatically inherit
the line mesh dataset from the swept surface. The lines through the depth will however
adopt the default number of mesh divisions. Since one element only is required through
the depth of the plate the default number of mesh divisions must be set to one.

e Select the Meshing tab.
e Change the default number of mesh divisions to 1 and click OK

Now the volume that represents a quarter of the plate can be created.

El Rotate the model to an isometric view to see the volume created.

e Select the Surface (use the Ctrl and A keys together to select whole model).

él Sweep the surface to form a volume.
e Enter a translation in the Z direction of 1 and click the OK button.

Now we assign a mesh to the volume. Because it is not a regular volume, a transition
mesh is required.




Modelling

e Double click on the mesh dataset Composite Brick (HX16L) and select the
Allow transition pattern option.

Note. Transition meshing is
required to enable the five sided
surface to be  modelled
predominantly with
quadrilaterals. ~ When  using
transitional meshing Modeller
will  introduce  compatible
triangular elements as necessary.

e C(lick OK to change the
mesh dataset.

e Use the Ctrl and A keys to select the whole model and assign the mesh dataset
Composite Brick (HX16L)

e C(lick on Z N/ to return the model to the default view from the Z axis.

Material Properties

Properties of a number of the more commonly used composite materials are available
from the composite library. The plate in this example is made up from a four layer

stack of IM Carbon UD.
| Attributes e Select the material IM | Composite Library X
\Materal > Carbon UD Vf=60% o, rroperice Key Propsties
Composite from the drop down list
Library... rom the drop down list. Material ~|IM Carbon LD WF=60% v =
. E 9.0E3
e Ensure the option for ® Compasite properties g
3D Solid is chosen. ® 10 Sl R -
. () Plane Strain
e Select the option to Ux(T)
output parameters for ) Failure criteria uym [s00
the Hashin damage
mOdel Cancel Apply Help
e Click the OK button to add the selected composite material properties to the oo
Treeview.
Defining the Composite Stack
| Attributes o Select the Solids and Shells option and click Next

Composite...

e Select the New button.
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The Add Lamina dialog will appear.

Defining lamina 1

The Name for the first lamina will be = addLamina
automatically entered as Laminal

MName | Lamina4 |

The material will automatically be
entered as 1:0rth® (IM Carbon UD

V=60% - Hashin Damage) g feinsisc
. Angle
e Leave the thickness as 1 and the
angle as 0 oK Close Help

e Click the Apply button to define
the lamina and create a second lamina.

Material 1:0rth1 (IM Carbon UD Wf=60%: - Hashin Damage] ~

Defining Iamina 2 Selids and Shells x
e Lamina2 will be automatically Normal | Grid
entered for the lamina name. Layer
: of 4 New... | [mnsert... | | Delete
e Leave the thickness as 1 but hame [Lamina2 \
change the angle to 90 Material | 1:0rth1 (IM Carbon UD VF=60% - Hashin Damage)
Thickness Volume fraction
e (lick the OK button. angle

Define a symmetrical stack

e Select the Symmetric button to
generate a four layer stack.

Composite lay-ups are defined with lamina 1 at the bottom

Visualise...

Automatic lamina names based on prefix Reverse
e Enter the dataset name as
. . ame | Laminate Stack w| F (new)
Laminate Stack and click the e | |
OK button. o Rpply Help

Note. The lamina thickness values to be entered for solid models comprised of
Pentahedral or Hexahedral composite elements are relative values, not absolute real
thicknesses, and represent the proportion of the total thickness (as specified by
geometric properties) apportioned to each lamina. In other words, for solid models
comprised of Pentahedral or Hexahedral composite elements the sum of all the
specified lamina thicknesses will always occupy the geometric thickness defined.

Assigning the Composite Stack

The composite stack now needs to be assigned to the volume so that the zero fibre
directions run along the length of the plate. To do this, a local coordinate system is




| Attributes

Local Coordinates. ..

Modelling

defined such that the local axes defined correspond to the global axes. The composite
stack is then assigned relative to this local coordinate system.

Ensure a Rotate Angle of 0 about the Z-axis is set. Enter the dataset name as
Global and click the OK button.

Use Ctrl and A keys together to select the whole model and from the P 3
Treeview drag and drop the composite dataset Laminate Stack onto the
selected features.

On the Assign Composite dialog ensure Assign to Volumes is selected. Select
the Local Coordinate option, ensure the dataset Global appears in the drop
down list and click the OK button.

Visualising lamina directions

Now the laminate stack is assigned to the model the lamina orientation can be checked
by visualising the lamina directions.

In the Treeview click on Attributes with the right hand mouse button and
select Properties

Select the Composite tab, then select the All datasets option.
Click on the Settings button.

On the Visualisation
Settings dialog select the
Visualise ply directions
option and ensure Surface
position Middle and Axis
x are selected.

Click the OK button to
return to the Attribute
properties.

Click the OK button to
visualise the layer directions.

In the P 3 Treeview, in the Composite Laminate Stack section right-click on
Lamina 2 and select the Set Lamina Active option.

Other lamina directions may be checked by setting each lamina active in turn.

Turn off visualisation of ply directions by going to the A Treeview clicking on
Laminate stack with the right hand mouse button and de-selecting Visualise
assignments..
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Supports

Symmetry supports need to be assigned to the lines of symmetry of the model. This is
best done by viewing the plate from above.

e C(lick on 2N/ to return the model to the default view from the Z axis.

1. Drag a box to select this vertical Surface
and assign support Symmetry YZ Plane

R i

3. Drag a box to
select this
vertical Surface
and assign
support Fixed in
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2. Drag a box to select this vertical Surface
and assign support Symmetry XZ Plane

e Drag a box around the Surface on the vertical axis of symmetry.
e Drag and drop the support dataset Symmetry YZ from the P Treeview.

e Ensure the Assign to surfaces option is selected and click OK to assign the
support dataset.

e Similarly drag a box around the Surface on the horizontal axis of symmetry and
assign the support dataset Symmetry XZ from the o Treeview to it.

The model also needs to be restrained from moving in the out of plane direction.

e Drag a box around the Surface on the right hand side of the model and assign
the support dataset Fixed in Z from the & Treeview.

Loading

The plate is to be placed under a tensile loading using a prescribed displacement.

| Attributes o Seclect the Displacement, velocity, acceleration option then the Prescribed
Loading... > displacement option and click Next

e Enter a Total displacement in the X direction of 0.1.
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e Enter a dataset name of Prescribed Displacement and click the Finish button.

e Drag a box around the Surface defining the right hand end of the plate and
assign the dataset Prescribed Displacement from the S Treeview.

e Click OK to assign to Analysis 1 and Loadcase 1.

El Select the isometric view button and check the supports and loading have been
applied as shown in this image.
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Analysis Control

Because this is a nonlinear problem the load incrementation strategy needs to be
defined.

e From the C Treeview expand Analysis 1 right-click on Loadcase 1 and from
the Controls option select the Nonlinear & Transient option.

The Nonlinear & Transient dialog will appear.
e Select the Nonlinear option.
e Set Incrementation to Automatic
e Set the Starting load factor to 0.5

e Set the Maximum change in load factor to 0.25
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e Set the Maximum total load factor as 1

e Leave the Maximum number of time steps or increments as 0 as this ensures the
solution will continue until the maximum load is reached.

Monlinear & Transient

Incrementation Solution strategy
Same as previous loadcase
Incrementation Automatic “ Max number of iterations 2

Starting load factor Residual force norm 0.1

Max change in load factor | 0.25 Displacement norm 0.1

Max total load factor Advanced...

| Adjust load based
e Incremental LUSAS file output

Iterations per increment Same as previous loadcase

Time domain Plat file I:l
Two Phase
0.0

Max number of saved restarts D
100.0E6
Automatic time stepping
Advanced...

[ save a restart at the end of this control
Common to all

Max time steps or increments ICI
Cancel Hep

e C(Click the OK button to finish.

To avoid mechanisms in the element formulation when some of the Gauss integration
points fail, it is necessary to switch on fine integration for the elements.

| File e Select the Options tab and click on the Element options button. Ensure that
Model Properties. .. Fine integration for stiffness and mass (structural) is selected and click OK.
Click OK to finish.

Saving the model

Fil
| IeSave El Save the model file.




Running the Analysis

Running the Analysis

| File

A

[New...

El Open the Solve Now dialog and press OK to run the analysis.

Note. In running this nonlinear analysis a number of load increments are evaluated.
An indication of the time remaining can be obtained by observing the number of the
increment being evaluated.

A LUSAS Datafile will be created from the model information. The LUSAS Solver
uses this datafile to perform the analysis.

If the analysis is successful...
Analysis loadcase results are added to the @ Treeview.

In addition, these files will be created in the LUSASFiles\<model name> folder:

0 composite_plate.out This output file contains details of model data,
assigned attributes and selected statistics of the analysis.

0 composite_plate.mys This is the LUSAS results file which is loaded
automatically into the Treeview to allow results processing to take place.

If the analysis fails...

If the analysis fails, information relating to the nature of the error encountered can be
written to an output file in addition to the text output window. Any errors listed in the
text output window should be corrected in LUSAS Modeller before saving the model
and re-running the analysis.

Rebuilding a Model

If it proves impossible for you to correct the errors reported a file is provided to enable
you to re-create the model from scratch and run an analysis successfully. You may
download this file from the user area of the LUSAS website.

U composite_plate_modelling.lvb This file carries out the modelling of
the example.

Ql Start a new model file. If an existing model is open Modeller will prompt for
unsaved data to be saved before opening the new file.

o Enter the file name as composite_plate
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e Use the default User-defined working folder.
o Ensure an Analysis category of 3D is set.
e Click the OK button.

Note. There is no need to enter any other new model details when a script is run to
build a model, since the contents of the script will overwrite any other settings made.

To recreate the model, select the file composite plate modelling.lvb that was
downloaded and placed in a folder of your choosing.

;l Rerun the analysis to generate the results.

Viewing the Results

Loadcase results for each increment can be seen in the ™ Treeview. For a nonlinear
analysis the last solved increment will be set active by default.
El If necessary, select the isometric view button.

e If present, turn off the Geometry, Attributes and Deformed mesh layers in the
Treeview.

Stress Contours

e In the @ Treeview ensure the final load increment Increment 3 Load Factor =
1 is Set Active

For solid models the lamina results can be selected for the top, middle or the bottom of
any selected lamina. For this example the middle of selected laminae will be viewed.
By default LUSAS will automatically transform results into the material direction.

e With no features selected click the right-hand mouse button in a blank part of

the view window and select Contours to add the contours layer to the
Treeview.

The contour Properties dialog will be displayed.
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Viewing the Results

e Select entity results of Stress
- Solids lamina (middle) of
component Sx and click the
OK button.

o In the & Treeview expand
the Composite Strip layup
entry and right-click on the
Laminal and Set Lamina
Active

The contour key should be showing a maximum stress in the lamina X material
direction of around 1.9E3

Note. When displaying layer contours the contours are displayed at the layer position
through the thickness of the model.

e In the & Treeview, in the
Composite  Laminate  Stack
entry, right-click on Lamina2
and Set Lamina Active

The contour key should be showing a
maximum stress in the lamina X
material direction of around 762.

Failure Contours

When using the Hashin failure model the failure indicator (IFFLR) can be contoured.
The indicator has the following values:

Indicator (IFFLR) Description
0-1 No failure
1-2 Matrix failure
2-3 Fibre failure
3+ Matrix and fibre failure

To display contours of the failure index for layer 2:
e Double-click the Contours layer name in the = Treeview.
The contour Properties dialog will be displayed.

o Select entity results of Stress Solids — lamina (middle) of component IFFLR.
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Select the Appearance tab, and for the Classic contour press the Set button.
Set the contour interval to 1.
Set the maximum contour value to 3

Set the minimum contour
value to 1 and click OK

Click OK again to display
contours of Hashin failure
in the material fibre
direction for Lamina 2.

By zooming in the region
of failure can be seen in
more detail.

z

N

By changing the active

loadcase it can be seen that

no failure has occurred after the first load increment (a load factor of 0.5). By
the second load increment (a load factor of 0.75) a small amount of matrix
failure has occurred adjacent to the hole.

This completes this example.
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